' Approved for Release by ' [ :
AA-2025 Professienal Délickofane ff&eFrisiniig - WaskiHop - www.i online.com/atl2025

<l\‘___\ t Data Unleashed

g ——_ SO A Power Bl Case Study
e sl N i y

Patrick Casey, Quantech Services

Government Support: Ms. Jacqueline Farrell, Cost Chief
\ AR Cyber & Networks Directorate (AFLCMC/HNF) §

T v\
.‘ Contractor Support: Mr. Alex Smith
‘ ’
\%\\\“ Director, Business Analytics (Quantech Services) §

p 13-15 May 2025




A

SN/ o b P TE a
BN N/ T o RN s e
=

S — )

g i _ ‘!‘ e :
-OTLent o "ﬂ,@“ S

* From Excel to Insight

e Power Bl in the DoD

Use Case 2 — LCAT Level Delta Analysis
Use Case 3 — Projected LCATs + FTEs

e HN Labor Rate Database Overview

Future Actions & Enhancements

Power Bl Pitfalls

 HN Labor Rate Power Bl Snapshots

* Power Bl 101: The Ribbon, Linking,
Visualizations, & Sharing

<1

[ ]
llllll)l)

* Power Bl 201: One-to-Many Relationships Conclusion

* Power Bl 301: Creating Groups Within Fields

* Demographics & Counts Power Bl Tab
* Labor Rate Dashboard Power Bl Tab

* Decomposition Tree Visualization

“ : »” H
Ctrl + Click” Quantech Logo on Any Slide to Return Here QU
Approved for Release by 66" ABG/Public Affairs Office — #66ABG-2025-009 Q g y - ANTZSCW(HM

ervices, I
{The Sum of Quality}



* Why Transition from Excel to Power BI?

* While Excel has been a cornerstone for data entry and analysis since 1985, its
limitations in handling dynamic data require a more modern approach.

* As analytical needs grow, transitioning to tools like Power Bl allows for
deeper insights, better collaboration, and real-time updates that Excel cannot
natively provide.

* Power Bl’s Strengths for Advanced Analytics (2015):

* Designed to extend Excel’s capabilities by introducing interactive dashboards
and integrating seamlessly with Microsoft 365.

* Real-time updates and interactive tools improve data storytelling and
decision-making, aligning with modern analytical demands.

 Why Power Bl Was Chosen:

* |ts ability to integrate multiple data sources into a single platform simplifies
reporting and reduces manual data processing.

* Provides a balance between flexibility for small-scale projects and scalability
for enterprise-wide initiatives.

* Enables accessible analytics across teams, fostering collaboration and ‘ Zl 'ANTZCH
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https://learn.microsoft.com/en-us/training/modules/explore-power-bi-service/1-why-power-bi
https://learn.microsoft.com/en-us/training/modules/explore-power-bi-service/1-why-power-bi

* Microsoft’s DoD Integration:

* Microsoft has long supported DoD operations with secure, scalable solutions across its
platforms, with a growing focus on cloud services and data security to meet DoD needs.

 Power Bl as Part of the Microsoft Suite:

* As a key component of the Microsoft 365 suite, Power Bl integrates seamlessly with
familiar tools like Excel, SharePoint, and Teams.

* Power Bl leverages the DoD’s investment in Microsoft products, enabling intuitive data
sharing and collaboration across secure networks.

* Power Bl Service for Real-Time Intelligence:

* Power Bl Service, the cloud-based extension of Power BI, provides DoD analysts with
real-time insights, allowing on-the-fly decision-making.

* Built with security compliance in mind, Power Bl service aligns with DoD security
protocols.

QUANTZCH

Approved for Release by 66" ABG/Public Affairs Office — #66ABG-2025-009 senices, inc

{The Sum of Quality}



(LCAT) Labor Rates for reasonability versus other data points.

Labor rate database originated in HNCN and utilized 345 data points from HNCP, HNCX, HNCJ, and HNCD.
» All labor rates are fully loaded/burdened with fees from various contract documentation (Actuals, B-Tables, Proposal Negotiation Memorandums).
* “LCAT Subcategory” was assigned to all contract LCAT titles using a standard mapping (meant to be customizable).

* 3600 Raw Indices were used for normalization calculations.

After this database was briefed to all of HN, 566 additional
data points were obtained from HNAA, HNAB, & HNI.

Anonymization & Rate Obfuscation

* Vendor names, program names, branch names, and vendor-specific labor
categories were abstracted to protect the identities of all involved parties.

* To further ensure no actual dollar values were tied to any data shown, all labor " e / o

_ ~ —
e ¢ _ \ e . e
rates were obfuscated by taking each rate's percent delta from the average ﬁ, wm ﬁ, D* ,l_l:n_l, ='W

and multiplying by $100. | |
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https://learn.microsoft.com/en-us/training/modules/explore-power-bi-service/4-collaborate-and-share
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Contract Labor Rate Data Fields (Alphabetically) > >

Ctr Labor Rates - Mame of Table in "HNC Labor Rate Database 26Aug24" Excel File
+ Appropriation - Used in Normalization Equation (All 3600 Currently)
+ Business Size (LB/SB/U) - Large Business, Small Business, Unknown
+ Contract #/ Source Title - 656 Data Points w/Contract Info
+ Contract Name - 25 Unigue Contracts
+ Contract Position Title - Rawest Labor Category (LCAT) Input
+ CONUS/OCONUS - Continental US/Cutside Continental US
+ HN Branch - 10 Unigue Branches within HNC
+ Input Date - Date Data Was Entered Into Database
+ Input Name - Initials of Data Collection Specialist
+ Input Rate - Rawest Labor Rate, Tied to Input Rate FY
+ Input Rate FY - Fiscal Year of Input Rate, Used in Inflation Equation
+ Known Subcontract (Sub/U) - Some Info Here Regarding Subs...

+ Level - Junicr, Journeyman (Mid), Senior, SME
+ Normalized FY - Fiscal Year To Inflate Rate To (Currently 2024)

PowerBl 101: The Ribbon, Linking, Visualizations, & Sharing

1. The Power Bl Ribbon: The Ribbon in Power Bl is similar to other Microsoft Office products and erganizes commands
into tabs for easy access.

+ Home Tab: This is where you can find the mest commanly used features, like imperting data, creating new visualizations, and

refreshing your data,

+ Insert Tab: Use this to add various visual elements, such as charts, buttons, and text boxes.

+ Modeling Tab: Here, you can work with data models, create calculated columns, and manage relationships between tables.

+ View Tab: Adjust your view, including themes, and toggle visibility for certain features like gridlines and snap to grid.

+ Data Tab: Focus on data queries, transformations, and editing tables directly.

2. Linking Power Bl with Excel
Power Bl integrates seamlessly with Excel, allowing you to impaort and link data for analysis.
+ Importing Excel Data: Click on the "Home™ tab, then select *Get Data®. Choose *Excel” from the data sources, and navigate to your

PowerBI 201: One-to Many Relationships (LCAT Key)

1. Understanding Relationships in Power Bl
In Power Bl, relationships define how data from different tables are connected.
These relationships allow you to pull in data from multiple tables into a single report or visualization.
+ One-to-Many Relationship: This is one of the mast common types of relationships. It connects a single record from one table (the
"one" side) to multiple records in another table (the “many” side).
+ Example: Imagine you have two tables: Crders and Customers. Each customer can place multiple orders, so the relationship
between Custemers (one) and Crders (many) is a cne-to-many relationship.

2. Replacing VLOOKUP with a One-to-Many Relationship
In Excel, VLOOKUP is often used to pull data from one table into another based on a matching value.

« N lized Rate - Input Rate Inflated to Normalized Fiscal Year (FY24)

+ Program - 18 Unigue Programs

+» Source - Contract Rates, B-Tables, or PMN

+ Sub-Program - 32 Unique Program Sub-Elements/Phases

+ Subcategory - Based on Ctr Position - Cleaned Contract Position Titles
Used in One-to-Many Model Relationship w/LCAT Ke-'.‘f Table

+ Vendor - 35 Unigue Vendors

+ Vendor Avg Growth (or Varies, Unknown) - For Future Escalation Analysis

+ Vendor Division - For Potential Future Analysis

+ Work Location City (Qpt) - Optional Field for Potential Future Analysis

+ Work Location State (Qpt) - Optional Field for Potential Future Analysis

+ Zone - Hardship Duty Zone, Hostile Zone, or N/A

LCAT Key - Name of Table in "HNC Labor Rate Database 26Aug24” Excel File
+ Calculated Labor Category - Mapping of LCAT Subcategory Into 10 Categories
+ Subcategory - Based on Ctr Position - Cleaned Contract Position Titles
Usad in One-to-Many Model Relationship w/Clr_Labor_Rates Table
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PowerBl 301: Creating Groups Within Existing Fields

In Power Bl, you can create custom groups or categories within an existing field to
better segment and analyze your data. This feature is particularly useful when you want
to group certain values together for reporting purposes, without modifying the
underlying data.

1. Why Create Groups?
Creating user-identified groups allows you to:
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Demographics & Counts (911 Labor Rates) - Linked Tables Containing Various Data Fields Along with Count of
Applicable |, Single Selection on Click, & Multiple Selection on Ctrl+Click

+ Sep23 Original Database Included (345 Labor Rates)

+ Aug24 Data Added (566 Labor Rates)

Labor Rate Dashboard - Fully Linked Slicers & Bar Graphs, Drill Down on Labor Category Bar Graph for Level, Drill Down
on Vendor Bar Graph for Labor Subcategory

Decomposition Tree - Interesting Visuzlization Depicting the Robustness of the Dataset

Contract Labor Rate Data Fields (Alphabetically) > >

Ctr Labor Rates - Mame of Table in "HNC Labor Rate Database 26Aug24" Excel File
+ Appropriation - Used in Normalization Equation (All 3600 Currently)
+ Business Size (LB/SB/U) - Large Business, Small Business, Unknown
+ Contract #/ Source Title - 656 Data Points w/Contract Info
+ Contract Name - 25 Unigue Contracts
+ Contract Position Title - Rawest Labor Category (LCAT) Input
+ CONUS/OCONUS - Continental US/Cutside Continental US
+ HN Branch - 10 Unigue Branches within HNC
+ Input Date - Date Data Was Entered Into Database
+ Input Name - Initials of Data Collection Specialist
+ Input Rate - Rawest Labor Rate, Tied to Input Rate FY
+ Input Rate FY - Fiscal Year of Input Rate, Used in Inflation Equation
+ Known Subcontract (Sub/U) - Some Info Here Regarding Subs...

+ Level - Junicr, Journeyman (Mid), Senior, SME
+ Normalized FY - Fiscal Year To Inflate Rate To (Currently 2024)

PowerBl 101: The Ribbon, Linking, Visualizations, & Sharing

1. The Power Bl Ribbon: The Ribbon in Power Bl is similar to other Microsoft Office products and erganizes commands
into tabs for easy access.

+ Home Tab: This is where you can find the most commonly used features, like imperting data, creating new visualizations, and

refreshing your data.

+ Insert Tab: Use this to add various visual elements, such as charts, buttons, and text boxes.

+ Modeling Tab: Here, you can work with data models, create calculated columns, and manage relationships between tables.

+ View Tab: Adjust your view, including themes, and toggle visibility for certain features like gridlines and snap to grid.

+ Data Tab: Focus on data queries, transformations, and editing tables directly.

2. Linking Power Bl with Excel
Power Bl integrates seamlessly with Excel, allowing you to import and link data for analysis.
+ Importing Excel Data: Click on the *Home™ tab, then select *Get Data®. Choose *Excel” from the data sources, and navigate to your

PowerBI 201: One-to Many Relationships (LCAT Key)

1. Understanding Relationships in Power Bl
In Power Bl, relationships define how data from different tables are connected.
These relationships allow you to pull in data from multiple tables into a single report or visualization.
+ One-to-Many Relationship: This is one of the mast common types of relationships. It connects a single record from one table (the
"one" side) to multiple records in another table (the "many” side).
+ Example: Imagine you have two tables: Crders and Customers. Each customer can place multiple orders, so the relationship
between Custemers (one) and Crders (many) is a cne-to-many relationship.

2. Replacing VLOOKUP with a One-to-Many Relationship
In Excel, VLOOKUP is often used to pull data from one table into another based on a matching value.

« N lized Rate - Input Rate Inflated to Normalized Fiscal Year (FY24)

+ Program - 18 Unigue Programs

+» Source - Contract Rates, B-Tables, or PMN

+ Sub-Program - 32 Unique Program Sub-Elements/Phases

+ Subcategory - Based on Ctr Position - Cleaned Contract Position Titles
Used in One-to-Many Model Relationship w/LCAT Ke-'.‘f Table

+ Vendor - 35 Unigue Vendors

+ Vendor Avg Growth (or Varies, Unknown) - For Future Escalation Analysis

+ Vendor Division - For Potential Future Analysis

+ Work Location City (Qpt) - Optional Field for Potential Future Analysis

+ Work Location State (Qpt) - Optional Field for Potential Future Analysis

+ Zone - Hardship Duty Zone, Hostile Zone, or N/A

LCAT Key - Name of Table in "HNC Labor Rate Database 26Aug24” Excel File
+ Calculated Labor Category - Mapping of LCAT Subcategory Into 10 Categories
+ Subcategory - Based on Ctr Position - Cleaned Contract Position Titles
Usad in One-to-Many Model Relationship w/Clr_Labor_Rates Table

PowerBl 301: Creating Groups Within Existing Fields

In Power Bl, you can create custom groups or categories within an existing field to
better segment and analyze your data. This feature is particularly useful when you want
to group certain values together for reporting purposes, without modifying the
underlying data.

1. Why Create Groups?
Creating user-identified groups allows you to:
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Demeographics & Counts (911 Labor Rates) - Linked Tables Containing Various Data Fields Along with Count of
Applicable , Single Selection on Click, & Multiple Selection on Ctrl=Click

» Sep23 Original Database Included (345 Labor Rates)

» Aug24 Data Added (566 Labor Rates)

Labor Rate Dashboard - Fully Linked Slicers & Bar Graphs, Drill Down on Labor Category Bar Graph for Level, Drill Down
on Vendor Bar Graph for Labor Subcategory

Decomposition Tree - Interesting Visualization Depicting the Robustness of the Dataset

PowerBI 101: The Ribbon, Linking, Visualizations, & Sharing

1. The Power Bl Ribbon: The Ribbon in Power Bl is similar to other Microsoft Office preducts and organizes commands
into tabs for easy access.

» Home Tab: This is where you can find the most commonly used features, like importing data, creating new visualizations, and

refreshing your data.

» Insert Tab: Use this to add various visual elements, such as charts, buttons, and text boxes.

* Modeling Tab: Here, you can work with data models, create calculated columns, and manage relationships between tables.

» View Tab: Adjust your view, including themes, and toggle visibility for certain features like gridlines and snap to grid.

» Data Tab: Focus on data queries, transformations, and editing tables directly.

2. Linking Power Bl with Excel
Power Bl integrates seamlessly with Excel, allowing you to import and link data for analysis.
+ Importing Excel Data: Click on the "Home" tab, then select *Get Data®. Choose "Excel* from the data sources, and navigate to your

PowerBl 201: One-to Many Relationships (LCAT Key)

1. Understanding Relationships in Power Bl
In Power B, relationships define how data from different tables are connected.
These relationships allow you to pull in data from multiple tables into a single report or visualization.

+ One-to-Many Relationship: This is one of the most commaon types of relationships. It connects a single record from one table (the
r table (the *many”

“one" side) to multiple records in anoth 1
+ Example: Imagine you have two tables: Crders and Customers. Each customer can place multiple orders, so the relationship
between Customers (one) and Orders (many) is a cne-to-many relationship.

2. Replacing VLOOKUP with a One-to-Many Relationship
In Excel, VLOOKUP is often used to pull data from one table into another based on a matching value

Contract Labor Rate Data Fields (Alphabetically) > >

Ctr Labor Rates - Name of Table in "HNC Labor Rate Database 26Aug24" Excel File
= Appropriation - Used in Normalization Equation (All 3600 Currently)
+ Business Size (LB/SB/U) - Large Business, Small Business, Unknown
+ Contract #/ Source Title - 656 Data Points w/Contract Info
« Contract Name - 25 Unique Contracts
« Contract Position Title - Rawest Labor Category (LCAT) Input
» CONUS/OCONUS - Continental US/Qutside Continental US
« HN Branch - 10 Unique Branches within HNC
« Input Date - Date Data Was Entered Into Database
« Input Name - Initials of Data Collection Specialist
« Input Rate - Rawest Labor Rate, Tied to Input Rate FY
» Input Rate FY - Fiscal Year of Input Rate, Used in Inflation Equation
+ Known Subcontract (Sub/U) - Some Info Here Regarding Subs...
« Level - Junicr, Journeyman (Mid), Senior, SME
« Normalized FY - Fiscal Year To Inflate Rate To (Currently 2024)
» Normalized Rate - Input Rate Inflated to Normalized Fiscal Year (FY24)
+ Program - 18 Unique Programs
« Source - Contract Rates, B-Tables, or PMN
» Sub-Program - 32 Unique Program Sub-Elements/Phases
+ Subcategory - Based on Ctr Position - Cleaned Contract Position Titles
Used in One-to-Many Mode! Relationship w/LCAT Key Table
« Vendor - 35 Unique Vendors
+ Vendor Avg Growth (or Varies, Unknown) - For Future Escalation Analysis
+ Vendor Division - For Potential Future Analysis
« Work Location City (‘g\m] - Optional Field for Potential Future Analysis
+ Work Location State (Opt) - Optional Field for Potential Future Analysis
+ Zone - Hardship Duty Zone, Hostile Zone, or N/A

LCAT Key - Name of Table in "HNC Labor Rate Database 26Aug24” Excel File
» Calculated Labor Category - Mapping of LCAT Subcategory Into 10 Categories
« Subcategory - Based on Ctr Position - Cleaned Contract Position Titles
Used in One-te-Many Mode! Relationship w/Ctr_Labor Rates Table
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PowerBI 301: Creating Groups Within Existing Fields

In Power Bl, you can create custom groups or categories within an existing field to
better segment and analyze your data. This feature is particularly useful when you want
to group certain values together for reporting purposes, without modifying the
underlying data.

1. Why Create Groups?
Creating user-identified groups allows you to:
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Demeographics & Counts (911 Labor Rates) - Linked Tables Containing Various Data Fields Along with Count of
Applicable , Single Selection on Click, & Multiple Selection on Ctrl=Click

» Sep23 Original Database Included (345 Labor Rates)

» Aug24 Data Added (566 Labor Rates)

Labor Rate Dashboard - Fully Linked Slicers & Bar Graphs, Drill Down on Labor Category Bar Graph for Level, Drill Down
on Vendor Bar Graph for Labor Subcategory

Decomposition Tree - Interesting Visualization Depicting the Robustness of the Dataset

PowerBI 101: The Ribbon, Linking, Visualizations, & Sharing

1. The Power Bl Ribbon: The Ribbon in Power Bl is similar to other Microsoft Office preducts and organizes commands
into tabs for easy access.

» Home Tab: This is where you can find the most commonly used features, like imperting data, creating new visualizations, and

refreshing your data.

» Insert Tab: Use this to add various visual elements, such as charts, buttons, and text boxes.

* Modeling Tab: Here, you can work with data models, create calculated columns, and manage relationships between tables.

» View Tab: Adjust your view, including themes, and toggle visibility for certain features like gridlines and snap to grid.

» Data Tab: Focus on data queries, transformations, and editing tables directly.

2. Linking Power Bl with Excel
Power Bl integrates seamlessly with Excel, allowing you to import and link data for analysis.
+ Importing Excel Data: Click on the "Home" tab, then select *Get Data®. Choose "Excel* from the data sources, and navigate to your

PowerBl 201: One-to Many Relationships (LCAT Key)

1. Understanding Relationships in Power Bl
In Power B, relationships define how data from different tables are connected.
These relationships allow you to pull in data from multiple tables into a single report or visualization,
+ One-to-Many Relationship: This is one of the most commaon types of relationships. It connects a single record from one table (the
“one"” side) to multiple records in another table (the “many” side).
» Example: Imagine you have two tables: Orders and Customers. Each customer can place multiple orders, so the relationship
between Customers (one) and Orders (many) is a cne-to-many relationship.

2. Replacing VLOOKUP with a One-to-Many Relationship
In Excel, VLOOKUP is often used to pull data from one table into another based on a matching value.

Contract Labor Rate Data Fields (Alphabetically) > >

Ctr Labor Rates - Name of Table in "HNC Labor Rate Database 26Aug24" Excel File
« Appropriation - Used in Normalization Equation (All 3600 Currently)
+ Business Size (LB/SB/U) - Large Business, Small Business, Unknown
+ Contract #/ Source Title - 656 Data Points w/Contract Info
« Contract Name - 25 Unique Contracts
« Contract Position Title - Rawest Labor Category (LCAT) Input
» CONUS/OCONUS - Continental US/Qutside Continental US
« HN Branch - 10 Unique Branches within HNC
« Input Date - Date Data Was Entered Into Database
« Input Name - Initials of Data Collection Specialist
« Input Rate - Rawest Labor Rate, Tied to Input Rate FY
» Input Rate FY - Fiscal Year of Input Rate, Used in Inflation Equation
+ Known Subcontract (Sub/U) - Some Info Here Regarding Subs...
« Level - Junicr, Journeyman (Mid), Senior, SME
« Normalized FY - Fiscal Year To Inflate Rate To (Currently 2024)
» Normalized Rate - Input Rate Inflated to Normalized Fiscal Year (FY24)
+ Program - 18 Unique Programs
« Source - Contract Rates, B-Tables, or PMN
» Sub-Program - 32 Unique Program Sub-Elements/Phases
+ Subcategory - Based on Ctr Position - Cleaned Contract Position Titles
Used in One-to-Many Mode! Relationship w/LCAT Key Table
« Vendor - 35 Unique Vendors
+ Vendor Avg Growth (or Varies, Unknown) - For Future Escalation Analysis
+ Vendor Division - For Potential Future Analysis
« Work Location City (Q.Bt;) - Optional Field for Potential Future Analysis
+ Work Location State (Opt) - Optional Field for Potential Future Analysis
+ Zone - Hardship Duty Zone, Hostile Zone, or N/A

LCAT Key - Name of Table in "HNC Labor Rate Database 26Aug24” Excel File
» Calculated Labor Category - Mapping of LCAT Subcategory Into 10 Categories
« Subcategory - Based on Ctr Position - Cleaned Contract Position Titles
Used in One-te-Many Mode! Relationship w/Ctr_Labor Rates Table

PowerBl 301: Creating Groups Within Existing Fields

In Power B, you can create custom groups or categories within an existing field to
better segment and analyze your data. This feature is particularly useful when you want
to group certain values together for reporting purposes, without medifying the
underlying data.

1. Why Create Groups?
Creating user-identified groups allows you to:
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* First of 2 primary tabs created for utilization.

HMN Branch # of Rates Contractor # # of Rates
Program 1 Sub-Program 1 57 | Has a1 | Contractor 1 57 * This tab was created to highlight data distributions.
Program 10 Sub-Program 24 17 HMAB 22 Contractor 10 2
Program 11 Sub-Program 23 2| Hneo 102 | Contracter 1 : * The other Labor Rate Dashboard tab was created for quick
Program 12 Sub-Program 23 19 HMNCJ 56 Contractor 12 4
Program 13 Sub-Program 23 20 HNCP 102 | Contractor 12 5 Subset retrleval and ana|y5|5.
Program 14 Sub-Program 25 12 HMNCX 85 Contractor 14 6
Program 15 Sub-Program 26 29 HMI 76 Contractor 15 6
Program 16 Sub-Program 27 33 HMIB 38 Contractor 16 7
Program 17 Sub-Program 238 39 HNII 124 Contractor 17 12
Program 18 Sub-Program 29 37 HMNIT 254 Contractor 18 11
Program 2 Sub-Program 2 4 Total 211 | Total 911
Program 3 Sub-Program 3 19
Program 3 Sub-Program 5 z v ot Rotes * Use Cases focus on how Labor Rate data and Dashboard
Program 3 Sub-Program 6 1 Calculated Labor Category # of Rates - . .. . .
Program3  Sub-program 7 1| ey sy | Joumeyman 28 Tab should be used in Pricing vs. Estimation.
Program 4 Sub-Program 4 35 Data Science 60 )
K Senior 303
Program 3 Sub-Program 10 20 Design 30 SME 521
Program 5 Sub-Program 11 1 FM, Contracting & Analysis 39 UNK 31
Program 5 Sub-Program 12 3 IT/Day 2 Operations 75 Total 911
Program 5 Sub-Program 13 10 Management 170
Program 5 Sub-Program 8 17 Platform Development 114
P 5 Sub-P g 24 d | Zone # of Rates 1 1 H
e =¥/ okt Detelopment = * Note, due to current data limitations, there are some
rogram & Sub-Program 14 23 Technical Writing 21 Hardship Duty Zone 20
Program & Sub-Program 15 12 Tast 12 TrEilE T 20 1 .
Program & Sub-Program 16 7 Total 211 N/A a7 Ways thls data ShOUId n_Ot be used‘
Program 6 Sub-Program 17 30 Total 911 . .
Program 6 sub-progrem 18 6 * Grouped LCAT Averages applied to FTEs (average highly
Program 6 Sub-Program 19 17 Obf ted Labor Rat ] ] . . .
Program 6 Sub-Program 20 7 pecated menorTate Pt influenced/skewed by high/low data points).
Program 7 Sub-Proagram 21 124 §20.66 §32549
Program & Sub-Program 22 38 ' . ° 1 1 (
jesent e 2| s0es M 510000 3540 | O O Labor Rates applied to estimated FTEs (labor rate analogy
Total 911 H H H
P — R should be applied to similarly scoped effort).
- D 4 b Table of Contents & Instructions Demographics & Counts Labor Rate Dashboard Decompasition Tree
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e Use Case 1 represents the most impactful application of
the HN Labor Rate Database in its current state.

* Use Case 1 assumes the following:

* The program is in source selection and wants to determine
if the rates proposed are fair and reasonable.

e Contractor 23 is the most likely candidate.
* The program has stated no SMEs are required.

* Program requirements are for Cybersecurity, Data Science,
Management, SW/Product, & Design support.

* Proposed LCAT/Level combinations can now be
compared to the historical database’s 87 relevant rates.
* This process aligns closely with FAR 15.404-1, which

emphasizes price reasonableness determinations based on
cost or price analysis.

* Beyond identifying rate discrepancies, this use case
encourages deeper exploration into underlying factors.

~

YA
&7
\\\\‘\\;\vr/

Labor Rate by Category & Program

Calculated Labor Category @ Cybersecur... FM, Contra... @ Data Scien... @Managem... @ 5SW/Produ..
Cybersecurity $50.65

FM, Contracting & Analysis
Data Science

Management

Calculated Labor Category

Design

Technical Writing

Design @ Technical ..

M Joumneyman
M Junior
I B senior

L | SME

1 UNK
L — =
Zone

LCAT Subcategory 56
LCAT Subcategory &6 _ 569.09
LT subcategory 67 MMM <c4.12
LCAT Subcategory 74 _ $64.05
LCAT Subcategory 78 _ 56093
LCAT Subcategory 83 _ $60.40

LCAT Subcategory 54 _ 35879

LCAT Subcategary 72 _ $59.27

LCAT Subcategary &2 _ 3890

LCAT Subcategory 73 _ §54.52

LCAT Subcategory 15

b
=
2

Fabricated LCAT Subcategory #

50 $20 240 %60 a0

Average of Obfuscated Labor Rate

0 0 0 0 Clear all Filters
Average of Obfuscated Labor Rate
Labor Rate by Vendor - ) =g Obfuscated Labor Rate

$20.66 ‘494] $94.39

81 $45.10 $16.46
# of Rates Median of Standard deviation
Obfuscated ab.. | of Obfuscated La...
Obluscated Labor Rate -
£20.66 $325.49

O O

Approved for Release by 66" ABG/Public Affairs Office — #66ABG-2025-009 QlJANTZCH

services, inc
{The Sum of Quality}



Diostn ed at Jt_he ICEA

st

Use Case 2 explores the strategic implications of labor
category transitions, offering insights into the cost
dynamics of adjusting workforce compositions.

e The program has stated that they want to replace all Data
Science Journeyman FTEs with Senior FTEs.

* No one isin a Hardship/Hostile Zone.

If the Data Science team consists of multiple vendors, the
average labor rate could increase by 50%.

If the vendor is known, then the average labor rate could
be expected to increase by approximately 56%.

This analysis enables decision-makers to anticipate the
financial impact of such transitions, accounting for

vendor-specific labor rates, project requirements, and
potential cost increases.
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* The last use case assumes a small contract with a defined LCAT labor breakout is up for renewal.

* The PM/PK team has provided you with the period of performance, the current (and future via a sole-source J&A)

vendor information, and the following contract FTE breakout:

Data Science Subcategory 189
SW/Product Dev Subcategory 204
Management Subcategory 187
Management Subcategory 188

e Using the HN Labor Rate Dashboard, we can obtain the corresponding labor rates.

* We can now compute costs [FTEs * Hours per Year *

» Companion paper outlines many concerns to LCAT + FTE estimation based on PM/EN input.

Senior
Journeyman

Junior

Labor Rate] using appropriate risk factors and inflation.

* Validity of Program Analogy, Fidelity of Labor Breakout, Etc.
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* Adding New Data Points:

* Continual addition of relevant data points enhances analysis depth and insight.

* Expanding with fresh information supports evolving needs and maintains dashboard relevance over time.

* Annual Inflation Updates:

* Adjusting for inflation each year ensures rate comparisons remain accurate and reflect
economic conditions.

* Automating inflation adjustments could streamline updates and maintain consistency.

e Obtaining New Data Fields:

* Pursue new fields, such as FTE allocation per year, to enable weighted average calculations,
providing more precise labor cost estimates.

* Access to enriched data fields allows for granular analysis, increasing dashboard versatility.

* Implementing a Delta Analysis Tool:
* A Delta Analysis tool would track changes in labor rates over time, flagging significant shifts.
* This function helps monitor budget impacts and contract adjustments, which is essential for proactive cost management.
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Key Cautions for Sustainable Dash
N A s i N

* Dashboard Aging & Maintenance: * Column Names & Data Mapping:
* Regular updates are essential; outdated data or * Avoid renaming columns within the dataset without
visuals lead to diminishing accuracy and relevance. updating in Power Bl; mismatched names cause
» Set a review cadence to keep data connections and errors and disrupt visualizations.
insights current, ensuring continued reliability. e Consistent column names and data hierarchies

improve model stability and help maintain clarity for
future users.

* Documentation & Naming Standards: e Data Source Permissions & Access Controls:

e Comprehensive documentation makes dashboards » Ensure permissions are updated as teams evolve;
easier to update and troubleshoot, especially when unexpected access changes can lead to broken links
transitioning between analysts. or missing data.

* Consistent file naming and storage locations are e Implement robust access controls to safeguard
critical for keeping models linked and accessible, sensitive information and maintain compliance.

avoiding broken data connections.
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* Power BIl: Transforming Cost Analysis

* Power Bl has proven essential in turning complex data into clear, actionable insights. From basic to advanced
functions, it enables users to dive deep into data, enhancing cost analysis capabilities.

e Our journey covered everything from Power Bl basics (Power Bl 101) to advanced techniques (Power Bl 301),
demonstrating the power of a well-structured, intuitive dashboard.

‘e

e HN Database & Dashboard in Action

* The HN Labor Rate Database and Power Bl Dashboard are live and :
actively supporting HN Leadership in data-driven decision-making. 11 |

* This tool is maintained with consistent updates, including inflation
adjustments and efforts to add new data fields, ensuring continued
accuracy and relevance.

“ i
* Requesting Access
* Those interested in exploring this dashboard can reach out through proper channels to request access.
* Due to the proprietary nature of the data, access is limited and may be restricted based on clearance, network

access, and other security protocols.
QUANT CH
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* Power Query:

* DAX (Data Analysis Expressions) * Power Query provides a robust * Power Query prepares data,
is a powerful formula language ETL (Extract, Transform, Load) ensuring it’s clean and
exclusive to Power BI, enabling tool within Power BI, allowing structured; DAX then enables
complex calculations and data users to clean, transform, and complex analysis, making the
manipulations. reshape data before analysis. two tools highly complementary.

* Key features include merging

* Common uses include creating queries, unpivoting data, and * Leveraging both tools optimizes
calculated columns, measures, appending tables from various Power Bl dashboards,
and custom aggregations, which sources, which is crucial for transforming raw data into
are essential for dynamic creating consistent, reliable meaningful, interactive insights.
reporting. datasets.

A. The measure name, Total Sales.

B. The equals sign operator (=) indicates the formula’s beginning.

C. The DAX function SUM adds up all of the numbers in the Sales[SalesAmount] column.
D. Parenthesis () surrounds an expression containing one or more arguments.

E. The referenced table, Sales.

F. The referenced column, [SalesAmount], is in the Sales table.

X + |[1 Total Sales = SUM{Sales[Salesfmount])

QUANTZCH
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https://learn.microsoft.com/en-us/power-bi/transform-model/desktop-quickstart-learn-dax-basics
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